Happy Holidays!  
from The PCLinuxOS Magazine
In This Issue ...

3 From The Chief Editor's Desk
5 Meemaw's 2016 Holiday Gift Guide
8 YouCanToo's 2016 Holiday Gift Guide
10 Screenshot Showcase
11 Paul's 2016 Holiday Gift Guide
15 All I Want For Christmas
16 PCLinuxOS Recipe Corner: Glazed Pork Chops
17 Inkscape Tutorial: Sliced Text
18 Screenshot Showcase
19 Playing Need For Speed: Hot Pursuit 2 On PCLinuxOS
21 Repo Review: Guitar-Related Programs
24 Screenshot Showcase
25 Download Entire YouTube Playlists With youtube-dl
27 PCLinuxOS Family Member Spotlight: AnalogueMan
28 Screenshot Showcase
29 Inkscape Tutorial: Using Envelope Deformation To Manipulate Text
31 Screenshot Showcase
32 PCLinuxOS Bonus Recipe: Cake Mix Cinnamon Rolls
33 ms_meme's Nook: Wonderful PCLOS
34 Tip Top Tips: How To Save Media Files To Device In Correct Order
35 Game Zone: Kickass Commandos
36 Screenshot Showcase
37 PCLinuxOS Puzzled Partitions
41 More Screenshot Showcase
From The Chief Editor's Desk

The holidays are supposed to be happy, joyous times. It's the time when we witness the wonder and amazement on children's faces as they pass by a holiday display. It's supposed to be a time when we ponder the possibility of peace on Earth and goodwill towards all, perhaps being more receptive than at any other time of the year to the idea of everyone just getting along.

But this year, there are two things that are draining the holiday spirit and cheer faster than that cup can be refilled.

First, as I'm sure every member of the human race is aware, the U.S. just held their quadrennial Presidential elections. And what a nasty, nasty election it was. As a natural born U.S. citizen, it was one of the nastiest elections I had ever witnessed. Both sides slung so much mud at one another that they alone could have filled the deepest, largest chasm on Earth. The candidate that was projected to have the slimiest of chances of winning (projected by a media and pollsters who, it was discovered, had the greatest of biases for his opponent), actually won. The non-politician, a businessman, beat the career politician, who's résumé is riddled with more scandals and corruption than there are drops of water in all the oceans. I'm sure the ramifications of this election, it's results, and how it came to be will be studied and debated for many years to come.

As if the election wasn't hard enough to endure, the supporters of the losing candidate – the same people who profess love, peace, tolerance and understanding – are now not only crying like babies about the results (their candidate was a sure bet, they thought), but are now rioting in the streets, assaulting supporters of the winning candidate, and generally acting like the sorest of sore losers. Basically, their rhetoric of love, peace, tolerance and understanding is being exposed as just that: rhetoric. Their actions betray their support for those idyllic and lofty traits for which they spent so much time preaching. There is little else that can draw out someone's true colors (be it an individual or a group) than the sportsmanship, grace and dignity that they display when losing.

Second, there is the ever-present and incessant greed of retailers for the holiday shopping rush. This year, retailers started putting out holiday merchandise around (or even slightly before) the U.S. Labor Day holiday at the end of August. At least in the U.S., there is an evil, greed-driven abomination called “Black Friday.” Supposedly, the retailers' sales on the day after Thanksgiving are a predictor of profits during the holiday shopping season, arguably their busiest time of year. Not to be outdone (and so they don't miss out on their piece of greed pie), online retailers originally came up with their own version, called “Cyber Monday.” Now, both brick and mortar retailers and online retailers “participate” in both Black Friday and Cyber Monday.

Retailers will price some highly desirable items at ridiculously low prices, just to get customers into their stores. It stands to reason that increased traffic equals increased sales. Sometimes, and originally, name brand items were offered. But lately, those name brand items have largely been replaced with no-name products produced in someone's back bedroom in Bangladesh with the cheapest components and materials ever conceived by someone making three cents an hour. Sure, you might get a 52 inch HDTV for $300, but it'll be a proverbial roll of the dice if it still even functioning six months from now. And don't even think about getting it repaired. If it stops functioning, it becomes $300 of landfill fodder.

If you think anyone who has something to sell is immune, think again. I received the following in an email on ... yep, you guessed it ... Cyber Monday. Even the Linux Foundation was getting in on the act, claiming their piece of the pie. And how can you blame them? At least the $300 spent with the Linux Foundation on Linux certification classes has infinitely more value than the same $300 spent on a
It's Time For The Linux Foundation Cyber Monday Training Sale!

Get up to 70% off Linux SysAdmin certification and training and a free limited-edition 25th Anniversary of Linux T-shirt
Our annual Cyber Monday Training Sale is here with a new T-shirt design and even more discounted bundles! From today, November 20 through Wednesday, November 30, you can get:

- LF5201 Essentials of System Administration and Linux Foundation Certified System Administrator exam bundle for $179 (55% off)
- LF5211 Linux Networking and Administration/Linux Foundation Certified Engineer bundle for $179 (55% off)
- Both bundles together for only $229 (70% off)

As with last year, when you purchase any bundle during the sale we'll throw in a free limited-edition 25th Anniversary of Linux T-shirt. Accelerate your Linux IT career today!

Donate To PCLinuxOS

Community Supported.
No Billionaires/Millionaires.
No Corporate Backing Or Funding.

Click here to make a one-time donation through Google Checkout.

Or, click one of the amounts down below to make a monthly, recurring donation.

no-name 52 inch HDTV that will likely be residing in a landfill inside of a year.

But for many retailers, having one day of mayhem and chaos isn’t sufficient. Nope. Many retailers now open their stores on Thanksgiving evening to milk just a little more profit from the masses. Others start their “Black Friday” sales on Wednesday. Not only is their greedy quest despicable and shameful, it can and has turned deadly. In the past, shoppers have been trampled to death in their quest for low priced junk. Neither I or my wife will be found within 1000 feet of a retail store on “Black Friday.” If you still don’t quite understand why, go to YouTube and enter “2016 black friday” as your search criteria. The videos you find are not atypical. They are the norm.

We hope that you don’t succumb to the manipulation of the retailers and mass media. Regardless of your religious affiliation, and regardless if you even believe in religion at all, try to remember the real reason for the winter holidays. Celebrate them safely, if you choose to celebrate them at all. At the end of it all, try to remember that the winter holidays all excel at one thing: bringing all people together in peace and harmony. Just because the retailers have lost the true meaning of the holidays doesn’t mean that you have to follow suit.

So, more so than ever, we at The PCLinuxOS Magazine bid you peace, happiness, serenity and prosperity. Happy Holidays!
Meemaw's 2016 Holiday Gift Guide

By Meemaw

Wow! It's that time again! I know there are people who shop for presents for months in advance, but I'm one of those "late shoppers" who waits until December to get all my presents. However, I was browsing the internet earlier and found a few "different" items that one might buy for someone who has all the "normal" stuff. One of my favorite sites is Bits & Pieces.

Bits & Pieces Historic Reproduction Storm Glass $19.99

If your friend is interested in the weather, this storm glass might be fun. It's supposed to change at the top according to the weather. From Bits and Pieces' website:

_Invented in the 19th century by sailor and meteorologist Admiral FitzRoy, this device is a liquid_and crystal filled storm glass that can predict the weather up to 2 days in advance. Changes in the crystal formations can indicate fair weather (clear liquid), rainy weather (murky liquid), thunderstorms (crystals at the top), cloudy skies with snow (large flaky crystals) and even windy weather (threads of crystals).

It's a nice decorative item which would look good anywhere.

Bits & Pieces Wrist Wallet $8.99

If you have a friend who walks, jogs or even rides, this would be a useful gift. I know when I walk, I don't want to carry a bunch of stuff, but I don't want to leave it in my truck either, in case someone is tempted to break into the truck. I could carry my driver's license and a few dollars (just in case) and not have to worry about it being in my truck.

Bits & Pieces Wine Chilling Stick $14.99

Your wine-loving friends will like this! You can put this in the freezer until you open a new bottle, then insert it into the bottle to chill the wine. Pour it from the chiller, put the lid on, and enjoy!

Bits & Pieces Deluxe Fishing Tool $24.99

Invented in the 19th century by sailor and meteorologist Admiral FitzRoy, this device is a liquid
This might be a great gift for someone who loves fishing. The tool contains a tape measure, weighted fish scale, serrated knife, hook remover, fish scraper, bottle opener, LED flashlight and a foldable stand. It's not any larger than some pocket knives I've seen, measuring 6” x 2.25”.

**PCLinuxOS Mousepad** $12.99

What better way to advertise your favorite distro? Anyone visiting your house, and seeing your computer setup can instantly see your mousepad.

I went to newegg to see what they had as well.

**UDI Discovery U818A-1 4CH RC Quadcopter w/ HD Video Camera** $59.38

This looks like a neat kit for teaching a youngster about electricity. From newegg's site:

*This innovative kit contains over 30 color-coded, real circuit components that snap together to create working electronic circuits and devices. Recommended for children 8 and older, this set offers 101 do-it-yourself projects that will give your child an entertaining, concrete education on how electronics work.*

I also went to L L Bean. ‘Oh yeah,’ you say, ‘why don’t you go somewhere less expensive?’ I understand that, but when their flannel shirts last about four times as long as the cheap ones, I figure that they are worth it. My husband has had flannel shirts he’s worn for over ten years. Many of the cheap ones wear out in three or less. They have good stuff.

**Snap Circuits Jr. SC-100 Kit ELEX0301 Elenco** $31.34

Radio Controlled items are big, as are drones these days. This is both. This quadcopter has a camera built in, and the price is lower than I would have thought.

**L L Bean Deluxe Scrabble & Monopoly** $149.00

This is a gift that's truly for the family that has everything. If they love playing Monopoly and/or Scrabble, this deluxe set should last longer. The case is wood, with the Scrabble board on one side of the lid and the Monopoly board on the other. The case contains all the pieces and the set also has a built-in lazy susan so you can rotate it around to each person while they take their turn. In true L L Bean style, you can have it monogrammed (for an additional charge).

**Family Archery Set** $169.00 to $179.00
My grandchildren have been in archery through the local 4-H organization (a very worthwhile organization for our youth!) However, this collection could make it very easy to learn about archery at home and allow the family to all enjoy it together. The price range is dependent upon the size of bow wanted and whether it is a right-hand or left-hand bow. This set includes everything pictured (the bow, three arrows, targets, bow stringer, arm protector and case.)

Bean's AstroMaster LT 60AZ Telescope $99.95

Many of us love to look at the stars, and telescope prices can range from one hundred dollars up to several thousand depending on how powerful it is. This model is one of five on their site and was in the lower range of prices. From their site:

Construction
• 20 mm and 10 mm interchangeable eyepieces.
• Rugged steel tripod with locking legs.

Additional Features
• Includes 60 mm aperture with multicoated optics for superior light transference.

• Includes astronomy CD and flashlight.
• StarPointer device helps locate celestial objects before viewing with telescope.
• Sky X astronomy CD locates and tracks 10,000 celestial objects.
• Red lens flashlight preserves night vision.
• Panhandle with clutch for smooth and accurate positioning.
• Quick-release dovetail attachment secures telescope to tripod.
• Deluxe tray beneath telescope for storage of eyepieces and accessories.

May this holiday season find you happy and healthy, and with those you love, enjoying your time with them.
It's that time of the year once again. He's making his list and checking it twice. Maybe instead of delivering you a “lump of coal,” he will bring you one of these instead.

Walcom Bamboo Smartpad $130.00

You don't have to say goodbye to your favorite notepad. With Bamboo Slate you can write your notes naturally with pen on any paper, convert your handwritten notes into 'living' digital files with the push of a button. Then store, synchronize, edit and enhance your notes and sketches on your iOS or Android Bluetooth enabled device with Wacom Inkspace.

Roku Express $29.00

Looking for our ultimate streaming player? Meet the new Roku Ultra for HD and 4K Ultra HD TVs. It comes fully loaded and delivers powerful streaming -- quad-core processing and 802.11ac dual-band wireless -- plus brilliant 4K* and 1080p HD streaming at 60fps, and vibrant HDR* color. Enjoy a lost remote finder, digital optical audio output, point anywhere remote, voice search, and headphones for private listening.

Logitech K380 Bluetooth Multi-Device Keyboard $30.48

Join the virtual reality world with Samsung Gear VR. Insert a Samsung phone and start playing video games or watching movies -- all, of course, in a virtual reality experience.
and laptop) and toggle between them with the first three function keys.

**Chromatic: LED Color Spectrum Clock**
$49.99

Now you can use light to tell time in a more spectacular way with the Chromatic: LED Color Spectrum Clock. This groovy clock, which you can hang on your wall or stand on a flat surface, contains 60 unique LEDs for vibrant display. There are 6 different animation modes, one of which is sure to make you happy.

**High Speed Dual USB Outlet**
$19.39

The smart intelliChip precisely reads the power need of your two devices to deliver optimal power accordingly without overcharging. Featuring the highest speed of power charging for two devices at the same time, this 4.0 Amps USB Charger is one of the best-selling products for end users, contractors and commercial areas. Users can charge two devices at the same time using the two USB hub ports and leave the two outlets free for other power needs. The product is compatible with USB 1.1/2.0/3.0 devices

**Man Candles**
$15.00

Forget the typical flowery scents and overly sweet fragrances of your average candle maker. The widely appealing Man Candles feature such universally loved scents as campfire, sawdust, fresh cut grass, homemade pizza, and more.

**Microchip Cufflinks**
$19.17

What geek wouldn’t love this awesome homage to the microchip that still manages to look swanky?

**PCLinuxOS Mug**
$14.95
Coffee tastes better in a PCLinuxOS mug! Mega Coffee Mug (4.5”x3.75”, 20 oz capacity). Durable ceramic with easy grip handle, classic coffee mug. Microwave safe. Hand wash only for easy use and care.

**Planet Gear Switch Plate** $40.00

These geared-up mechanical light switch plates transform an ordinary device into the perfect flourish for your secret library, steampunk chalet – or wherever your imagination lives! Made in San Diego, California.

**Screenshot Showcase**

*PCLinuxOS* Mate Desktop

*PCLinuxOS* KDE

*The Future is Here*

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

*PCLinuxOS* KDE

**Posted by tuxlink, November 2, 2016, running KDE.**
Paul's 2016 Holiday Gift Guide

by Paul Arnote (parnote)

Once again, the annual winter holiday season has descended upon us. It really does feel as if it comes around faster and faster every year.

Here are some gift ideas for those on your holiday gift list. Just as in previous years, there is a list from Meemaw, YouCanToo and me. Obviously, the items on each of the lists will be somewhat influenced by what each person finds interesting, or items that appeal to that person. It’s kind of that “different strokes for different folks” thing, shaped by varied likes and dislikes, and different life experiences. But, between the three lists, we are certain that you should be able to find some excellent holiday gift ideas.

All prices listed are in U.S. dollars.

**Ferrari Portugese Double Lever Corker** ... $13.59

One of my “newer” hobbies (actually, a rediscovered one) is homemade wine making. I had forgotten how easy it is to make your own wine at home. You won’t believe all the flavors you can make, limited only by your access to what 100% pure fruit juices (without preservatives, which prevent or retard the fermentation) are available near you. I’ve made red grape, white grape, apple, mixed berry, raspberry-strawberry, pomegranate, pineapple, cranberry, watermelon and black cherry wines, because I have access to 100% pure juices made from those fruits. Blended juices are fine, but not anything with preservatives.

Over the past year and a half, I’ve accumulated quite the collection of wine. I always have one or two batches fermenting at any given time, tweaking my recipes. Since neither I nor Laura drink alcohol much, we end up giving away quite a bit of it to friends and family.

Of course, once you make a batch of wine, you need to bottle it, which means you need a way to seal those bottles. There is little else that is as effective as using traditional corks to seal your filled wine bottles. But, without one of these, it’s extremely difficult (if not impossible) to get the corks into the wine bottles. This corker makes the task nearly effortless.

By the way, if anyone is curious about getting started making homemade wine, give me a shout in the PCLinuxOS forum. I’ll be happy to help steer you in the right direction. It’s easy and fairly cheap to get started. Don’t worry. Your first batch or two can be accomplished with a bare minimum of “equipment” ... like a disposable plastic gallon milk jug, a latex balloon, a rubber band, fruit juice, sugar, and yeast. You can buy the “other” equipment quite cheaply, later (this corker, along with a supply of inexpensive corks, should probably be one of your first “equipment” purchases). Meanwhile, ask your wine drinking friends to save their empty bottles for you to recycle while your first batch is fermenting, so you have something to use when bottling your batches of wine.

**Battlestar Galactica: The Definitive Collection [Blu-ray]** ... $93.99

If you have a Battlestar Galactica fan on your Christmas list, this will make the PERFECT holiday gift for them. No, I’m not talking about the very popular reboot of the series that appeared on the Syfy network. This collection is all about the original series from 1978.

PCLinuxOS Magazine
Included in this version is the theatrical release of the Battlestar Galactica movie/pilot that started it all out. Then, you get the entire television series. Finally, you also get the follow-up series, “Galactica 1980,” which takes place 30 years later when they finally find and arrive at Earth.

But wait … there’s more! There are also over four hours of bonus features, including over three hours of deleted scenes, along with multiple special featurettes.

**Hot Shot Men’s "Bulls-Eye" Pop-Top Mitten …**
$13.83

I don’t make it a secret that I enjoy hunting and the outdoors. There is nothing worse than being outdoors when the weather turns cold and having cold hands. (The U.S. Navy did a study on divers experiencing hypothermia and discovered that one of the most efficient ways to rewarm those divers was by warming their hands and feet). I use something just like these when I go hunting in the cold, and boy do they ever help to keep your hands warm. Mittens tend to be warmer than gloves, so you get the best of both worlds with these pop top mittens. As an added benefit, you can easily place a chemical hand warmer in the pop top part of each mitten, or (as I do) slide one of those hand warmers into the palm of each glove. When you need your fingers free to perform more delicate tasks, just flip the pop top part of the mitten back to free your fingers. A magnet sewn into the back of the pop top part of the mitten meets up with another magnet sewn into the back of the glove, holding the pop top part of the mitten stationary so that it doesn’t just swing around uncontrollably.

**Hot Hands Value Pack 10pk …** $5.00

Speaking of the chemical hand warmers, here’s an awesome buy that will make an excellent holiday gift for anyone on your holiday gift list who spends time outdoors during the colder months of the year. Hunters, ice fishermen, construction workers and mail carriers will all appreciate these. Simply open the package and you will have a safe heat source that will last for 10 hours. The hand warmer packets are activated by exposure to air, so don’t open their individual packaging until about 10 minutes before they are needed. These are excellent to slip into gloves. Some people also slide one down into their boots, or place them in the sweatband of their hats or caps. I find that they are a little too thick to place into my boots (because I am flat footed), but tossing one into your hat or cap certainly works well. If you are at a store that sells these, also be on the lookout for similar products that are designed for use as toe warmers and foot warmers, which work equally well, without the unnecessary extra thickness. By the way … these are single use items, and cannot be reused once they are depleted.

**Toddler Basic T-Shirt …** $11.99

If you have younger children on your holiday gift list to buy for, why not enlist their help in spreading the word about PCLinuxOS? This 100% cotton toddler t-shirt is available in sizes from 2T to 4T, and in blue, white, pink or yellow colors (pictured). Machine wash in cold water, inside out (to preserve the printing). Tumble dry on a low setting, or line dry. A portion of the proceeds from the sale of PCLinuxOS merchandise go to help support PCLinuxOS.
Baby Bodysuit (Onesie) ... $19.99

For the even newer arrivals, there is apparel for them that helps spread the word about PCLinuxOS, as well. Might as well have them dressed in this as they are passed around to all the adoring friends and family at holiday gatherings. This baby bodysuit (also called a onesie or a romper) is available in white, blue, pink and kiwi green. The size availability is for 0-3 months, 3-6 months, 6-12 months, 12-18 months, and 18-24 months. These short sleeved body suits are made from 100% cotton. Machine wash in cold water with like colors, and tumble dry on a low setting, or line dry. A portion of the proceeds from the sale of PCLinuxOS merchandise go to help support PCLinuxOS.

PCLinuxOS Cap ... $18.99

While you’re buying PCLinuxOS merchandise for others on your holiday gift list, you might as well pick up something for yourself, too. This PCLinuxOS cap would make a perfect way to help spread the word about PCLinuxOS. Available in white or khaki, this unstructured baseball cap is made of 100% cotton, and features a sweatband to wick away perspiration. A hook and loop adjustable band at the back allows this cap to fit a head circumference from 20 inches to 24 inches (50.8 cm to 61 cm). This item is listed as being hand wash only.

ETvalley 36 Watt Multi-Port 4 Port USB Outlet Wall Charger High Speed for Apple iPhone iPod iPad Samsung Android Tablets and Others (Black) ... $13.99

This standalone USB charger has enough “umph” to charge all of your devices, all at the same time. You can plug in an iPhone, a tablet, an Android phone and any other device that charges by way of a USB cable. Besides saving space, it also helps to reduce cable clutter. To top it off, this unit has received “five star” reviews almost across the board.

Lost in Space: The Complete Series [Blu-ray] ... $61.72
There you have it. Ten holiday gift ideas. Of course, if none of these work for those on your holiday gift list, then perhaps you'll find something more suitable on Meemaw's or YouCanToo's list of holiday gift ideas.

All of us at The PCLinuxOS Magazine wish you all the happiest, merriest of holiday seasons!

HQ ISSUE Multi-Band Dynamo & Solar Powered Radio … $49.99

* LED flashlight, 5 LED reading lamp and SOS emergency light built-in
* Protective rubberized case takes bumps, knocks
* USB port, DC charger port and headphone jack (USB cord, DC charger and headphones not included)
* Can run on 3 AA batteries (not included)
* Measures 8" x 2.5" x 5"h.
* Weighs 1.25 lbs. (0.57 Kg)

Keep informed and entertained at home or in the boonies.

No power? No problem. Even when you're miles from the nearest outlet, this military-inspired radio keeps you in touch with news, weather, music and more. Top solar panel converts sunlight into power/sound. No sun? Just hand-crank the integrated generator to listen to crystal-clear sound on multiple bandwidths. Listen to news, sports, music and important weather broadcasts miles from the nearest outlet.

Solar panel on top converts sunlight into listening power. Or, simply hand-crank the dynamo internal generator to provide listening "juice." Versatile and rugged wonder works virtually anywhere, providing vital news, entertainment or key weather information.

* 11 bands: AM/FM, shortwave 1-2 and weather bands 1-7

* NOAA weather alert sends dispatches directly to radio

Additional Features

* OVER 8 HOURS OF RARELY SEEN AND NEVER-BEFORE-SEEN EXTRAS
* 50th Anniversary Interviews with Original Series Cast Members
* Original Cast Reunion Performance of Bill Mumy's 1980 Unproduced Script, LOST IN SPACE: THE EPILOGUE
* Vintage Versions of 4 Original Network Episodes (AS SEEN ON AIR in the 1960s with Original TV Commercials and Bumpers)
* 1973 Animated Special
* 20th Anniversary Audio Interview with Lost in Space Series Creator Irwin Allen
* 2 Full-Length Lost in Space Documentaries
* Original Animated Series Concept Pitch Video
* Unaired Series Pilot Episode: "No Place to Hide"
* Original Network Commercials, Vintage Cast Interviews AND MUCH, MUCH MORE!
All I want for Christmas
is a 64-bit a 64-bit just a 64-bit
Gee if I could only have a 64-bit
Then I could
update my computer

It seems with my 32
I'll be sitting here a knittin'
Without those updates coming in
computing I'll be a quittin'

All I want for Christmas
is a 64-bit a 64-bit just a 64-bit
Gee if I could only have a 64-bit
Then I could
update my computer

Santa I don't want
pots pans or candy
I only need a 64-bit
and things will be fine and dandy

MP3

OGG
Glazed Pork Chops

Ingredients

- 1/4 cup brown sugar
- 1/2 tsp cayenne powder
- 1/2 tsp garlic powder
- 1/2 tsp paprika
- 1/2 tsp salt
- 1/2 tsp black pepper
- 2 Tbsp olive oil
- 4 thick cut boneless pork chops

Instructions

1. Preheat the oven to 350°F. In a small bowl, combine the brown sugar, cayenne pepper, garlic powder, paprika, salt, and black pepper.

2. Remove the pork chops from their package and rub the seasoning mixture over all sides of each chop. The moisture from the meat will help the seasoning to adhere to the surface.

3. Heat olive oil in a large, oven-safe skillet over a medium flame. When the oil begins to shimmer, add the pork chops. Cook the chops for about 5 minutes on each side, until nicely browned.

4. If your chops are greater than one-inch thick, transfer the skillet to the preheated oven for another 5-10 minutes to finish cooking. Test the chops with a meat thermometer to make sure the internal temperature has reached 145°F. Cook longer if needed.

5. Dredge the chops through the thick sauce in the bottom of the pan just before serving.
Inkscape Tutorial: Sliced Text

by Meemaw

I saw a cool tutorial a couple of months ago, and I wanted to share it with you. This will make a line of text look like it has been cut apart.

Create the text you desire. Then, single click the canvas with the text tool to create a normal text object (not a flowed text object). Don't change tools yet.

With the text tool still selected, place the cursor in between two of the letters in the text. Then hold down the ALT key and then press an arrow key on the keyboard. This will manually adjust the spacing between the letters (Kerning). Repeat this process for all the letters in your text. Wherever you place your cursor will cause all letters to the right of the cursor to be changed, so you will have to do each letter from left to right, depending on how you want it to look.

To make make our effect, we'll have to duplicate some of it, so let's first draw a triangle over your text using the path tool. I changed the color of the triangle to make it easier to see.

Next, select both the triangle and the text, and duplicate them (Right click > Duplicate or Edit > Duplicate). Make sure that you do not deselect them after the duplication. With one copy of the text / triangle combination still selected, choose Path > Intersection, to create the first piece to cut out. Click in the color bar and change the color of the triangle to something that will stand out (I chose green).

Finally, select the leftover red triangle and the other text path and choose Path > Difference. This will remove the triangle from the text. Repeat these steps on the black text as many times as you want.

Then, move the green sections out a bit to create the "shattered" or "sliced" look. Save your work, if you haven't done it already.

Now, you can combine all these separate pieces together by pressing CTRL+A to select all (or draw a box around them all with your cursor), then choose Path > Combine. After you do that, you can click on the color bar to change the text to your desired color.

We could stop here if we wanted. However, something else we can do is apply a "grunge" look to the text. We can use a splatter pattern and layer it over the text. You can create a splatter pattern and use the Path Effects menu to put the pattern onto a path. We did this in another tutorial, but we can do it here, too. Create some sort of splatter object and edit it so it looks the way you want (I did a rough circle that looks like a drop of paint). Now, using the pencil tool (or bezier tool) draw a path. Mine was kind of squiggly. Choose your splatter object and copy it to the clipboard (<CTRL>+ C). Click on your path and go to Path > Path Effects (near the bottom of the menu). Click on the plus sign to add the effect Pattern Along Path.
You will want to set your parameters before anything else. You should probably change your **Pattern copies to Repeated** so there will be more than one of your pattern on your path. I also set my Spacing to 1.00 so the path wouldn’t be one continuous pattern. Then click the clipboard towards the top to indicate the pattern is on the clipboard and is the one that should be used. I got one similar to this:

Place the pattern over your text.

Finally, select both the grunge and your text path, and choose **Path > Difference** to finish. The text will now look even more broken.

Have fun with this one! You can do as much or as little as you want. Depending on your triangle locations, it can look more or less “sliced”. Remember, both of these items need to be paths for the effect to work correctly.
Playing Need For Speed: Hot Pursuit 2 On PCLinuxOS

by Alessandro Ebersol (Agent Smith)

Need for Speed: Hot Pursuit 2 is a game produced by Electronic Arts and released for PlayStation 2, Xbox, GameCube and PC in October, 2002.

Two different versions were released, the PS2’s (made by EA Black Box) and, for other consoles and PC, made by EA Seattle. The PS2 version was considered the best by critics. It is the last game in the series to have the Ferrari cars, Holden Special Vehicles, and the last game of the classic generation. It is the second game of the Hot Pursuit series, thus the successor of Need for Speed III: Hot Pursuit and predecessor of Need for Speed: Hot Pursuit (2010).

And, it was the last game of the series before it became a copycat of The Fast and Furious. Yes, until this game, we had famous cars and racings on the roads. Then, afterwards, you only saw tuned cars and racing in the city (which I hated).

Gameplay

Hot Pursuit 2 draws primarily on the gameplay and style of Need for Speed III: Hot Pursuit; its emphasis was on evading the police and over-the-top routes with long shortcuts. As with the original, the player also has the option to play as a police officer, trying to arrest speeders. To achieve this, the player must hit the runaway vehicle several times to disable it. The player must turn on lights and sirens of his car while pursuing, and they automatically turn off after arresting the suspect. Police can ask for a barricade, additional units, "Unit 9" in the broadcasting service (only on PS2), spike belts and ask for help from a helicopter to aid target the pursued vehicle. In the end, the player’s score is based on the wrecked fugitive cars. In the PlayStation 2 version, this mode is called You’re the Cop while PC, GameCube and Xbox versions is Be the Cop.

The races take place in four environments that differ in the atmosphere, with a handful of courses per environment. The different courses in an environment are formed by different roads being connected or separated by roadblocks. A fictional tropical island, reminiscent of Hawaii, is the most varied environment. The course crosses a city, a volcano, a waterfall, a beach, a forest and two villages.

The environment of the coastal forest, reminiscent of the Washington coast because of its forest and nature, sometimes has a foggy weather, but that does not effectively limit visibility during races.

The Mediterranean coast, which resembles Greece because of the stadium and a building that resembles the Parthenon, and the so-called Alpine environments that resemble Alaska, are more homogeneous, with little variation, except one or other occasional shortcut.
NFS cars’ Editions also are in this game, the cars are the same as you see above, only slightly modified. However, in the PS2 version, the BMW cars did not receive their corresponding NFS Edition modifications. This occurred because of a BMW licensing policy restricting unauthorized vehicle modifications. Also in the PS2 version, the Ferrari 360 Spider did not get its NFS Edition corresponding modification due to the Ferrari 360 Modena Challenge being available as an alternative and exclusive to the PS2, while in other versions there is the Ferrari 360 NFS Edition available.

Install the game normally, if you have the media on CD. It will ask for the serial number and will install without problems.

Now, every time the game runs, you need to mount the CD which it was installed from.

There is another, more practical way, which is to make an ISO of the installation cd (with tools like AcetoneISO), install the game from the ISO that was created, and use a no-cd patch in the game executable nfshp2.exe.

However, the ISO must be mounted (the same AcetoneISO or CDemu) each time you run the game, since it plays the movies and music from the installation CD.

I hope you enjoy and have fun with the game, which, despite being 14 years old, it’s still fun to play, aged very well and won the Platinum seal on WineHQ AppDB.

All the pictures were captured from actual PCLinuxOS gameplay.

The game supports resolutions up to 1280 × 720 in wide 16:9 format, which is good, since many older games require workarounds to run on newer hardware. In terms of resource consumption, it works well on modest hardware (Core2Duo) and even Intel video cards achieve a good performance.

How to install and run on PCLinuxOS?

You will need Winetricks. In Winetricks select:

- Select Default Wine prefix
- Install a Windows DLL or Component
- Now, look for DirectX9: D3dx9_36 and mark it for installation

Next, install the game.
Repo Review: Guitar-Related Programs

By CgBoy

Ah, guitars... What wonderful instruments they are. Maybe you just like to strum along to a song. Or maybe you like to play awesome solos. This month I'm going to review programs useful to guitar players. Let's have a look at what's in the repository. I have put these in the order in which I reviewed them.

LINGOT

Who wants to hear an out-of-tune guitar? LINGOT is an easy to use musical instrument tuner. It has a nice, analogue style, gauge with a needle, and appears to be pretty accurate. It then, of course, shows you the closest note to the current estimated frequency.

LINGOT is very configurable, and can also be configured for tuning other instruments. LINGOT appears to be a fairly good tuner, and I've found it to work pretty well for tuning my guitar. Plus it's easy to use.

TuxGuitar

Ever wanted to write your own song for the guitar? Then TuxGuitar may be just the thing for you! It's a multitrack guitar tablature editor, with plenty of cool features. Although TuxGuitar has support for writing using normal sheet music, it's really intended as an editor for guitar tablature. It does handle tempo and time signature, though. It has a number of note effects, like "Bend", "Slide", "Vibrato", "Hammer-on/Pull-off", "Tremolo Picking", and more. It has a chord editor, where you can select and insert chords, or edit custom chords.

As I mentioned earlier, TuxGuitar is a multitrack editor, so you can have multiple tracks in your song, and then mix them together. It also gives you the option to add lyrics to your song. The music you write can then be played back using MIDI. TuxGuitar can also display the guitar fretboard, so you can see where to put your fingers to play the song.
TuxGuitar comes with a guitar tuner, that seems to work pretty well. Tuxguitar supports a number of file formats. It supports Guitar Pro files as well as other formats, like MIDI, PDF, WAV, and more. All in all, this is a good program for those wanting to write music for the guitar. I don't particularly like how note placement works. But maybe that's just me...

**Guitarix**

Guitarix is a virtual guitar amplifier that uses JACK. Now, I must admit that I don't know all that much about guitar amplifiers, or electric guitars in general, as I only have an acoustic guitar. But still, I will give a basic overview of the program. Guitarix has plenty of effects to use. Some of these effects include: "Wah", "Chorus", "Distortion", "Echo", and "Reverb". But there are plenty more then that. You can also load in LADSPA and LV2 plugins. It also allows you to record to an audio file (top, right).

The program does have a nice interface, though, with virtual dials and switches. Guitarix also comes with a number of presets to choose from. And Guitarix also includes a guitar tuner. The program is able to emulate various amplifier tubes. Plus, Guitarix can be controlled from an MIDI device. This looks like a good program, but because I don't have an electric guitar, I couldn't test it out properly.

**Free Music Instrument Tuner**

Free Music Instrument Tuner, or FMIT, is a good instrument tuner with a number of interesting features. It's got some features that LiNGOT doesn't have. It too has a digital needle. It too appears to be fairly accurate. And it too shows you the closest note to the current estimated frequency. But that's expected. And, FMIT can also be paused (next page, top left).

Rakarrack

Rakarrack is a guitar effects processor with many features. It uses JACK, and has a lot of guitar effects. Some of those include: “Distortion,” “Echo,” “Phaser,” “Reverb,” “Wah-Wah,” “Chorus,” and a lot more that I'm not going to list here. You can create presets, or use one of the many included. Rakarrack also comes with a guitar tuner and a metronome. And there's the “Analog Control Interface” which allows you to control an effect parameter with an analog signal.

And like Guitarix, Rakarrack can be controlled with an MIDI device. Rakarrack also has an experimental monophonic MIDI converter. Now, like I already said, I don't have an electric guitar, so I couldn't test out this program properly. But it does look like a great program for those who do have electric guitars.

Summary

Well, if you're looking for a dedicated guitar tablature editor, then you should try TuxGuitar. If you're looking for a good tuner, then I'd recommend FMIT. And if you want a virtual guitar amplifier, there's Guitarix. And finally, if you need a feature rich guitar effects processor, go for Rakarrack. Now, go and play some awesome Christmas carols on your guitar!
Does your computer run slow?

Are you tired of all the "Blue Screens of Death" computer crashes?

Are viruses, adware, malware & spyware slowing you down?

Get your PC back to good health TODAY!

Get

Download your copy today! FREE!

Posted by YouCanToo, November 12, 2016, running KDE.
Download Entire YouTube Playlists With youtube-dl

by Paul Arnote (parnote)

Without a doubt, YouTube is a treasure trove of billions of videos. Once a video is uploaded to YouTube, it remains there forever – unless it is taken down by the video owner, or by YouTube for copyright or terms of service violations.

Fortunately, not only are there literally tons of videos to keep you entertained, but some are placed into collections, called playlists. The playlists can help you find collections of related content that you might want to watch. My son likes episodes of Gumby, just like I did when I was a kid. Luckily, there are playlists for each season of Gumby, with all of the videos of each season in each playlist.

We’ve covered youtube-dl before in other articles in The PCLinuxOS Magazine. From those, you know how easy it is to download individual videos from YouTube to your computer. Once you have them downloaded, you can watch them from your hard drive, or you can burn them to a DVD or other storage medium to be played back on your television or portable DVD player. Since my son has a portable DVD player that we take along in the car/truck when we travel to see family who lives out of town, it would be nice to save these Gumby episodes to a storage medium that is recognized by his portable DVD player – either a DVD disc or an SD memory card (which his player recognizes, as well). Then, he can watch his Gumby episodes while traveling down the highway.

First, if you haven’t already done so, install youtube-dl from Synaptic. Youtube-dl is a command line program which will make it easy for you to download your videos and video playlists.
Next, search for (and hopefully find) the video playlist collection you want to download. Select it to cause the page to load. You might want to immediately hit the “pause” button to pause playback, since the first video in the list will immediately begin to play.

See the area highlighted with the red box in the above screen capture? It actually is a link to the entire playlist. Move your mouse cursor over that text, right click, and select “Copy Link Address” from the context menu that appears.

Now, you will want to open a terminal session. Use the cd command to change to the directory where you want to save your downloaded videos. If there isn’t already a directory, make one, then switch to it.

Then, you want to enter the following on the command line:

```
youtube-dl -cikt --format mp4 --yes-playlist VIDEO_PLAYLIST_LINK
```

VIDEO_PLAYLIST_LINK is the URL copied to the clipboard when you selected “Copy Link Address” above. For the initial command line arguments, here’s what they mean. The “c” means to resume partially downloaded files. The “i” means to ignore any errors. The “t” means to use the video title as the file name. The “k” means to keep the video on the disk after the post-processing is finished. The “--format mp4” portion of the command line means to save the video files as MP4 files, and the “--yes-playlist” portion affirms that the URL that follows points to a video playlist.

Below is an abridged version what the terminal output will look like:

```
$ youtube-dl -cikt --format mp4 --yes-playlist
https://www.youtube.com/playlist?list=PLTmd0UJlJpfJNPdmLZagcsopQZoGNCs
[playlist:playlist] PLTmd0UJlJpfJNPdmlZagcsopQZoGNCs: Downloading webpage
[download] Downloading playlist: A Gumby Adventure | Season 2
[playlist:playlist] playlist A Gumby Adventure | Season 2: Downloading 14 videos
[download] Downloading video 1 of 14
[youtube] -E3E0GEdcEI: Downloading webpage
[youtube] -E3E0GEdcEI: Downloading video info webpage
[youtube] -E3E0GEdcEI: Extracting video information
[youtube] -E3E0GEdcEI: Downloading MPD manifest
[download] Gumby - S2 Ep 1 - The Zoos- -E3E0GEdcEI.mp4 has already been downloaded
[download] 100% of 18.69MiB
[download] Downloading video 2 of 14
[youtube] 72dUePdujj0: Downloading webpage
```

If youtube-dl encounters a video that has already been downloaded (already exists in the destination directory), it will skip over it and move on to the next video in the playlist. You can see this reflected in the output from the first video of the playlist.

That really is about all there is to it. I’m certain you will find plenty of video playlists to keep you entertained for many, many hours. Just now, you can do more than just sit in front of your computer to watch them, by burning them to DVDs or other media.

```
commandlinefu.com
```
PCLinuxOS Family Member Spotlight: AnalogueMan

As told to YouCanToo

What is your name/username?
My name is Joe Alders, and my username is AnalogueMan.

How old are you?
Last January, I reached the age of seventy.

Are you married, single?
I am married for more than forty years, approaching forty-five years.

How about Kids, Grandkids?
God, in His Infinite Wisdom, did not give us children.

Do you have pets, what is your favorite?
I once had a cat: Mr. Perkins. He lived with us for almost twenty years. After he passed away, it took at least a year for me to get over it. Cats always have my greatest affection, but after the death of Mr. Perkins, I did not want another one around our house.

Are you retired, still working and if working, what do you do?
I am now in my tenth year of retirement and haven’t even had one dull day since retirement.

Where did you go to school and what is your education level?
I have an education in electronics engineering and designed Integrated Analogue Circuits as a senior designer at the Philips Semiconductors Company in Nijmegen.

What kind of things you like doing? hobbies, travel, fishing, camping?
My most important hobby is playing the classical guitar which I started playing when I was around fourteen years old. But during my professional life as an electronics designer, I was “on/off” practising it due to lack of time. But since my retirement, I am practising it almost every day for at least an hour. Although I am now retired, I am still designing electronic circuits but in stead of using semiconductors as amplifying elements, I am using vacuum tubes to design analogue audio amplifiers. Moreover, I read a lot of English, German and Dutch literature.

Why and when did you start using Linux?
Before I became a Linux convert, I was using Windows for a very, very long time. I started with Windows 95 then Windows XP and finally Windows 7. But in the last few years I got fed-up with those virus protection software. Although I always had installed the latest antivirus definitions, my computer got infected several times and had to get rid of sometimes very nasty infections. But the “turning point” reason that I switched from Windows to Linux was the fact that after having to install a new SSD because the old one crashed, I was forced to do a “fresh” Windows re-install because Windows refused
to re-install a backup which I dutifully made every week or so. Those backups, which I made using Microsoft's own backup software, appeared to be useless. Windows considered my repaired computer as a completely new one. Whatever I tried, I could not install one of my backups again. Then I kicked out Windows and went to Linux about one and a half years ago.

After that decision I had to go through a steep learning curve, because not only I had a lot to learn about Linux, but I also had to abandon a lot of programs which I used in Windows. I had purchased software from the Serif Company: Drawplus, PagePlus and PhotoPlus, which I used for writing and drawing and designing my electronic circuit diagrams, etc. It took me a lot of time to obtain some skills using Inkscape, Gimp and other free software as replacements. Not to mention how to make reliable backups in Linux.

PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.
Inkscape Tutorial: Using Envelope Deformation To Manipulate Text

by Khadis

In this tutorial, I would like to show you how to apply the envelope effect on a text to create a new “shape”. I am inspired by a poster in Flickr.

Let's go!

Create an ellipse using the Circle tool (F5). Choose any size and stroke color you like. No need to give it fill color. Convert it to a path by going to Path - Object to path menu or press Shift + Ctrl + C.

Using the Edit path tool (F2), modify the ellipse into a leaf shape. Look at the illustration below (note: you are free to make your own shape):

Type a text. I choose to type the same as the example above. So first, I typed “COMMERCIAL”. Use any fonts you like. Then, resize the text so that it almost covering the ellipse. Set the text so that the left and right edge stick to the leaf shape.

Now, convert the text into path by accessing Path - Object to path menu. Then, open up Path - Path effects (Shift + Ctrl + 7) panel.

Click Add path effect, and choose Envelope Deformation. Click Add.

Uncheck the Enable left & right paths option. Click on Top bend path icon to edit the upper side of the text (right, top).

Now, the upper part of the text is surrounded by green line. Drag the line so it sticks to the leaf shape. Do the same step for the lower part (choose the Bottom bend path first).
Inkscape Tutorial: Using Envelope Deformation To Manipulate Text

Now, you can remove the leaf shape while the enveloped text will remain there.

Later, create another leaf shape and another text, for example “RESIDENTIAL”. Do the same steps as above until you have the “leaves” you want.

For the stalk, you can make an ordinary curve using Bezier tool (Shift + F6). Then, type a text “THE POSSIBILITIES ARE ENDLESS”. Rotate it 90°. Put this text into the curve by selecting both the curve and the text, then select Text - Put on path. Hide the path by removing its stroke.

For the flower, you only need to follow the steps like you did on the leaves. Prepare another eight elliptical shapes containing words ORGANIC, HOME-MADE, BENEFICIALLY, NATURAL, RECYCLING, GREENER, ENVIRONMENTALLY, and CONVENIENT for the petals. You can color the text with a solid color or gradient color. Later, you can delete the ellipse shapes.

Create a circle and make the petal shapes go around the circle. How?

First, select the first petal shape and rotate it 90 degrees. Put it above the circle.

Double click the petal shape. You will see + sign in the middle of the petal shape. Move it to the center of the circle. You can also activate Snap an item’s rotation center option first. Ensure that your Snap Control Bar is active (go to View - Show/Hide - Snap Control Bar menu).

Open up Transform (Shift + Ctrl + M) panel and open the Rotate tab. Set the rotation angle to 45°, click Apply.

Click the second petal shape, move its center point (the + sign) to the center of the circle, and rotate it 45° twice.

Do the same step to other petals. For the third petal and later, rotate them 45° several time so that you achieve the right position.

Group all petal shapes and put them above the stalk. Make proper adjustment such as rotate them a bit.
The final result can be like this (or even much better):
**PCLinuxOS Bonus Recipe**

*from the kitchen of youcantoo*

**Cake Mix Cinnamon Rolls**

**Ingredients**

- 1 cup sugar
- 2 Tbsp butter (plus some for the pan)
- 1 cup unsweetened applesauce
- 2 cups all-purpose flour (plus 1 Tbsp)
- 1 tsp baking soda
- 1/2 tsp cinnamon
- 1/2 tsp ground cloves
- 1/4 tsp salt
- 1/4 tsp nutmeg
- 2/3 cup raisins

**Directions**

Allow the butter to come to room temperature. Preheat the oven to 350°F. Coat the inside of an 8x8-inch baking dish with butter.

In a large bowl, cream together 2 Tbsp of butter and the sugar using a hand mixer or mixing by hand with a wooden spoon. Add the applesauce and stir to combine.

In a separate bowl, stir together the flour, baking soda, cinnamon, cloves, salt, and nutmeg until well combined.

Pour the flour mixture into the applesauce mixture and stir just until combined.

In a separate small bowl, toss the raisins with about 1 Tbsp flour until they are lightly coated. Fold the flour coated raisins into the cake batter. Spread the cake batter into the prepared baking dish.

Bake the cake for 30-35 minutes, or until the center springs back when pressed. Let the cake cool for 15 minutes before slicing into 9 pieces.

*It’s easier than E=mc²*

*It’s elemental*

*It’s light years ahead*

*It’s a wise choice*

*It’s Radically Simple*

*It’s ...*
It's wonderful it's marvelous
PCLinuxOS glad I found you
Boots so fast meant to last
Best OS around

It's made my life so easy WOW
I'm telling everyone to get it now
It's wonderful it's marvelous

PCLinuxOS I love you

MP3

OGG
Tip Top Tips: How To Save Media Files To Device In Correct Order

Editor’s Note: Tip Top Tips is a monthly column in The PCLinuxOS Magazine. Each month, we will feature – and possibly even expand upon – one tip from the PCLinuxOS forum. The magazine will not accept independent tip submissions specifically intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS forum’s “Tips & Tricks” section. Your tip just may be selected for publication in The PCLinuxOS Magazine.

This month’s tip comes from PCLinuxOS forum member davEC$. 

It can be really frustrating, when your photo-display device or your personal stereo does not display or play your files in the right order. This is due to some devices just playing the files in the order they are saved, and the ext3/ext4 filesystems’ way of storing files (for speedier recovery). So, they are not saved in the order that you would expect, when bulk transferred to a FAT16 or FAT32 device. Now of course, when you use Linux, everything is sorted into the correct order when it’s important, but the copy command doesn’t do this. Fortunately the rsync command does.

Create a text file as above, give it a suitable name, and in the file manager, use right-click > properties to make it executable.

After rsync, only -ar is strictly necessary, but adding vP might be useful if you run the script in a terminal, so you can see what’s happening and get an idea of progress.

Oops! One thing I forgot to mention. Make sure your filenames do not start with a mixture of lower and upper case, unless you want all the uppercase ones to display or play first, and the lowercase ones afterwards.

***

Our dear and recently departed Tara-Rain-9.56 added in a reply to the original Tip & Trick that the following line should be able to perform a case insensitive sort on the file names (enter the command below all on one line):

```
find /sourcedir -type f -print0 | sort -f | xargs -J % % -0 rsync -arvP % /destinationdir
```

The command above should replace the rsync line in davEC$’s script above.
Game Zone: Kickass Commandos

by daiashi

About The Game

Basically, it’s a run and gun game. You complete certain missions and along the way pick up power ups and help. Does anyone remember Ikari warriors? It is very close to this. Battle your way against tanks, etc. Along the way, you will pick up things such as grenades, different guns, and ammo. You can also free POWs to aid you in your missions. It’s a little fast-paced but fun. Give it a try, and get your Rambo on.

System requirements:
Fully updated PCLinuxOS and Steam

Hardware:

Minimum:
  OS: PCLinuxOS
  Processor: 1.2 GHz+
  Memory: 2 GB RAM
  Storage: 250 MB available space
  Additional Notes: Supports Gamepad

About The Company

Founded in 2000, Anarchy Enterprises is an indie game studio that makes a variety of games for PC, Mac, Linux, iOS and Android. Their past titles include many Tycoon and puzzle games.

Some Gameplay Screenshots

Getting It To Run

Install Steam (if you don’t have it installed already), then start it. You will need to create a new account, if you do not already have one. Once you have Steam up and running, go to the store tab. Click on the
Linux tab if you wish and search for Kickass Commandos. Click on and download the demo. If you have updated your system, including graphics drivers, you should be good to go.

Commandos

The PCLinuxOS Knowledge Base
It Belongs To YOU!

Does your computer run slow?
Are you tired of all the "Blue Screens of Death" computer crashes?
Are viruses, adware, malware & spyware slowing you down?
Get your PC back to good health TODAY!
Get

Download your copy today! FREE!

Game Zone: Kickass Commandos

Screenshot Showcase

Posted by HERTZ, November 3, 2016, running KDE.
PCLinuxOS Puzzled Partitions

SUDOKU RULES: There is only one valid solution to each Sudoku puzzle. The only way the puzzle can be considered solved correctly is when all 81 boxes contain numbers and the other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled for you. You cannot change these numbers in the course of the game.

Each column must contain all of the numbers 1 through 9 and no two numbers in the same column of a Sudoku puzzle can be the same. Each row must contain all of the numbers 1 through 9 and no two numbers in the same row of a Sudoku puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no two numbers in the same block of a Sudoku puzzle can be the same.

SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can view them here. You have seven (7) letter tiles with which to make as long a word as you possibly can. Words are based on the English language. Non-English language words are NOT allowed.
2. Red letters are scored double points. Green letters are scored triple points.
3. Add up the score of all the letters that you used. Unused letters are not scored. For red or green letters, apply the multiplier when tallying up your score. Next, apply any additional scoring multipliers, such as double or triple word score.
4. An additional 50 points is added for using all seven (7) of your tiles in a set to make your word. You will not necessarily be able to use all seven (7) of the letters in your set to form a “legal” word.
5. In case you are having difficulty seeing the point value on the letter tiles, here is a list of how they are scored:
   0 points: 2 blank tiles
   1 point: E, A, I, O, N, R, T, L, S, U
   2 points: D, G
   3 points: B, C, M, P
   4 points: F, H, V, W, Y
   5 points: K
   8 points: J, X
   10 points: Q, Z
6. Optionally, a time limit of 60 minutes should apply to the game, averaging to 12 minutes per letter tile set.
7. Have fun! It's only a game!

Download Puzzle Solutions Here

Possible score 246, average score 172.
PCLinuxOS Word Find: December 2016
Palindromes

Palindromes are words, phrases or numbers that read the same whether you read them forward or backward. Some of the phrases are kinda funny, but we like to have fun! All of these are in the puzzle. The spaces and punctuation have been removed from the phrases.

TYNCQUGQSQJLRFMWMZAAKTXIRNCJ
INOSAKBZQWUXMYAUSEUZWMINPWETI
ZLLCJXJYDFOBSPIRKXETXTAESTD
KJEKXTGVICIAJDJURAFKCZKNKRRI
HYMTEWOKWTTDSXFZKTVRWWZAEFHD
GDONTNODNAMTKNSCGSQAENLDESFD
ZSNQCYDUCFQROTARTORTICJSQDAZDI
DGNWKPBPATPJTKZWRWOEEXEHCTRM
KCOWTPMTVSHXJCSTLZTCRKBGBMAI
LZMHSWIGVLADNEFKPLXSIAROFXHRCHT
XMEVZSGMRPJMGFRFYOFMFRRGNDYCAQ
MILDAULJCVBBSEDNRTTNHOOPNWFST
VROWTTTPSWSNQDPNTJWNGDRRUQACAS
PENEMUXVEINBRIGGVNFTVDRRRNKBHG
MFNITYISSOLOSVLOYGFMHSNAPVAZ
DEMJRNXKAYAKIXSPFTCEOAVMVKAMQ
TRDNXIHQCZQLZDFDTQISWSODISEBRNU
KMYKZDCYHVCIALEKGIATRNZOKRNJIE
JGRATAFZCEMMIESRVDVUYUWFWHEORWEEK
TRYFFQRGRYOVHGBKCFVINVKQNBWGWDTOOT
GKLLYUBHEIUBORROWOROBIRDVVK
NETCHVZFLRCMDHXZPHHNCWMTOXQFD
FDRAWNINWARDKRWOZAVXZOWCPRVWQP
AHUJVQKDENEFDIFIPANVNCGOWEIFKG
OAUIXGJTTFGJJWOEMSDYGPGVAIEU
OJIKQPFJKLZUNWPVNGAHIPREFERPIW
RBBFUEYDZFMADAMIIMADAMNYYZNSNIE
OTSPETFVUBEYNISBRABBQRYQRDRBYBI
WCXWSPJHMTGJNZFZZKMPJXHNDKGGULB
GUSHVJJAATWTVMYSOQYMHXPAGIAASDZ

civic
kayak
level
madam
noon
peep
radar
redder
refer
redivider
rotator
sagas
solos
stats
tenet
toot

Some palindromic phrases include:

Borrow or rob?
Don't nod
Drawn inward
I did, did I?
I prefer pi.
Madam, I'm Adam.
Ma has a ham.
Never odd or even
No lemon, no melon.
Now I won.
Nurses run.
Race car
Top spot
Was it a cat I saw?

Download Puzzle Solutions Here
**Holidays Crossword**

1. a day, varying in date but always in the spring, observed in certain states of the U.S. by the planting of trees.
2. March 17, observed by the Irish in honor of St. Patrick, the patron saint of Ireland.
3. July 14, a national holiday of the French republic, commemorating the fall of the Bastille in 1789.
4. a Mexican holiday marking the victory of Mexican troops over French forces in Puebla, Mexico, on May 5, 1862.
5. a day set aside in most states of the U.S. for observances in memory of dead members of the armed forces of all wars: now officially observed on the last Monday in May.
6. The annual festival of the Christian church commemorating the birth of Jesus.
7. a Canadian national holiday celebrated in commemoration of the formation of the Dominion on July 1.
8. (in Britain) November 5, celebrating the anniversary of the capture of Guy Fawkes.
9. a harvest festival celebrated from Dec. 26th until Jan. 1st in some African-American communities.
10. (in Britain) the first weekday after Christmas, when Christmas gifts or boxes are given to employees, letter carriers, etc.
11. a Jewish high holy day that marks the beginning of the Jewish New Year.
12. a Jewish festival lasting eight days.
13. November 11, a legal holiday in the U.S. in commemoration of the end of World Wars I and II and in honor of veterans of the armed services.
14. February 14, observed in honor of St. Valentine as a day for the exchange of valentines and other tokens of affection.
15. a day when practical jokes or tricks are played on unsuspecting people.

**Download Puzzle Solutions Here**

PCLinuxOS Magazine
Disclaimer

1. All the contents of The PCLinuxOS Magazine are only for general information and/or use. Such contents do not constitute advice and should not be relied upon in making (or refraining from making) any decision. Any specific advice or replies to queries in any part of the magazine is/are the person opinion of such experts/consultants/persons and are not subscribed to by The PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an “AS IS” basis, and all warranties, expressed or implied of any kind, regarding any matter pertaining to any information, advice or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable, at any time, for damages (including, but not limited to, without limitation, damages of any kind) arising in contract, tort or otherwise, from the use of or inability to use the magazine, or any of its contents, or from any action taken (or refrained from being taken) as a result of using the magazine or any such contents or for any failure of performance, error, omission, interruption, deletion, defect, delay in operation or transmission, computer virus, communications line failure, theft or destruction or unauthorized access to, alteration of, or use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are made as to the accuracy, adequacy, reliability, completeness, suitability, or applicability of the information to a particular situation. All trademarks are the property of their respective owners.

5. Certain links on the magazine lead to resources located on servers maintained by third parties over whom The PCLinuxOS Magazine has no control or connection, business or otherwise. These sites are external to The PCLinuxOS Magazine and by visiting these, you are doing so of your own accord and assume all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by users. The PCLinuxOS Magazine accepts no responsibility for the content, accuracy, conformity to applicable laws of such material.

 Entire Agreement
These terms constitute the entire agreement between the parties with respect to the subject matter hereof and supersedes and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding such subject matter.
More Screenshot Showcase

Posted by Meemaw, November 5, 2016, running Xfce.

Posted by weirdwolf, November 27, 2016, running LXDE.

Posted by jogurtmen, November 6, 2016, running KDE.

Posted by parnote, November 27, 2016, running Xfce.